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What Is Backup?

Microsoft Windows NT Backup is a graphical tool for protecting data from accidental loss or 
hardware and media failures. It makes it easy for you to use a tape drive to back up and 
restore your important files on either the NTFS, FAT, or HPFS file system. 
The following list provides an overview of some of the things you can do with this graphical 
tool to protect your data:

Back up and restore both local and remote files on an NTFS, FAT, or HPFS file system 
from your own computer using an attached tape drive.

Back up and restore Microsoft Exchange Server components, including the directory 
and the information store.

Select files for backing up or restoring by volume, directory, or individual filename 
and view detailed file information, such as size or modification date.

Select an optional verification pass to ensure reliable backups or restorations.
Perform any of the following common backup operations: Normal, Copy, Incremental, 

Differential, and Daily Copy.
Place multiple backup sets on a tape, and either append new backup sets or 

overwrite the whole tape with the new ones.
Span multiple tapes with both backup sets and files, because there is no file-size 

restriction.
Create a batch file to automate repeated backups of drives.
Review a full catalog of backup sets and individual file and directory information so 

you can select files to be restored.
Control a restore's destination drive and directory and receive appropriate options for

what action to take when a restore would overwrite a more recently created file.
Save log information on tape operations to a file. Also view tape-operation 

information in the Windows NT Event Viewer.
See Also
Overview of Backing Up Microsoft Exchange Components



Showing or Hiding the Status Bar and Toolbar

The Tree, View, and Window menus provide commands for manipulating your windows the 
same as in File Manager. A toolbar at the top of the window provides easier access to the 
most commonly used commands. The status bar at the bottom of the window provides 
descriptions of each of the commands and program-status information.
To show or hide the status bar and toolbar

From the View menu, choose Status Bar or Toolbar.
The screen changes to reflect your selection.

When either the Status Bar or Toolbar option is in effect, a check mark appears next to the 
command on the View Menu.
See Also
Changing the Font Selection



Changing the Font Selection

You can change the font that Backup uses to display the names of your files and directories.
You can also change the style and size of the font.    
To change the font selection
1. From the View menu, choose Font.
2. In the Font box, select the font that you want to use.

When you select a font, a style, or a size, the text in the Sample box changes to reflect
your choice.

3. In the Font Style box, select a style option.
4. In the Size box, select a point size. 
5. Clear the Lowercase check box if you want text to appear in all uppercase letters.
6. Choose the OK button.

The text in all the directory windows is displayed in the new font.
See Also
Showing or Hiding the Status Bar and Toolbar



Changing to a Different Tape Drive

The system automatically checks for the proper hardware when you start Windows NT and 
initializes it each time you start Backup. Notice, however, that the tape drive must be 
turned on before you start Windows NT for the drivers to be loaded properly. If you have 
more than one tape backup device, you can use the Hardware Setup command on the 
Operations menu to select a different device.
To change to a different tape backup device
1. From the Operations menu, choose Hardware Setup.
2. In the Hardware Setup dialog box, select the new tape backup device.
3. Choose the OK button.

Windows NT currently supports both high-capacity SCSI tape backup devices for 4 mm DAT,
8 mm, and 1/4-inch drives, and the less expensive mini-cartridge drives. You may have 
more than one tape drive connected to your system. However, only one tape drive may be 
selected at a time.
Inserting a higher density tape than the tape drive is capable of using can cause the 
program to display “Tape Drive Error Detected” and not allow the tape to be ejected until 
you close Backup.
Running Backup without a tape in certain tape drives can cause the Application log in Event
Viewer to be updated every 3 to 4 seconds with a “No Tape in Drive” message. This can 
eventually fill up the log and leave no room for other messages until you delete the log.
See Also
Loading a Tape Driver



Loading a Tape Driver

If this is the first time that you have used Backup or if you have just installed a new or 
additional tape backup device, you need to load the appropriate tape backup device driver 
and then restart your computer to activate it.
To load a tape driver
1. In the Main program group, double-click the Windows NT Setup icon.

After determining your hardware configuration, the Windows NT Setup dialog box 
appears.

2. From the Options menu, choose Add/Remove Tape Devices.
3. In the Tape Device Setup dialog box, choose the Add button to view a list of the tape 

devices that are compatible with Windows NT.
4. Select a device from the list, and choose the Install button.

A message asks you to type a path for the location of the Tape Device files and then 
choose Continue. The name of the selected tape device appears in the box in the Tape 
Device Setup dialog box.

5. Choose the Close button.
6. From the Options menu, choose Exit.

A message advises you that your computer configuration has changed and that you 
must shut down and then restart your computer to use the new configuration.

7. In the Setup Message box, choose the OK button.
To avoid restarting your computer, you can also use the Devices option in Control Panel
to start the tape device.

See Also
Changing to a Different Tape Drive



Opening and Updating the Drives Window

The Drives window will normally be open when you start the Backup program. However, 
sometimes you will want to minimize it and then reopen it when needed. There will also be 
times when you will leave Backup, use File Manager to connect to another network drive, 
and then return to Backup and need to update the Drives window to view the additional 
network drive.
To reopen and update the Drives window
1. To reopen the Drives window, double-click the Drives icon in the main Backup window.

--or--
From the Window menu, choose Drives.

2. To update the information in the Drives window, choose Refresh from the Window 
menu.

See Also
Opening the Tapes Window
Backing Up all the Files



Backing Up all the Files

You can select all the files on a disk shown in the Drives window. However, notice that even 
when a disk drive is selected, the program does not back up those files and directories that 
the user does not have permission to read. Hidden files with read permission can be backed
up and are displayed with an exclamation point in the file's icon. All file attributes are 
preserved, including permissions.
To back up all the files on a disk
1. In the Drives window, select the disk drive that you want to back up.
2. From the Select menu, choose Check, or choose the Check button on the toolbar.

--or--
In the Drives window, select the check box for the appropriate disk drive.

3. From the Operations menu, choose Backup, or click the Backup button on the toolbar.

See Also
Backing Up Individual Files
Setting the Tape Options
Using Batch Files For Backups



Backing Up Individual Files

Disk and Tape File Selection windows are organized the same as in File Manager, with the 
same options for viewing the directory tree structure and the directory and filenames list. If
you only want to select a few files, it is faster to select the check box for each filename.    
To back up individual files
1. In the Drives window, double-click the appropriate disk drive icon or letter to open the 

Disk File Selection window.
2. To select several files, select the first filename and then do one of the following:

Press and hold down the SHIFT key and then select the last contiguous filename. 
Drag the mouse to the last contiguous filename.
Press and hold down the CTRL key and then select each non-contiguous filename.

3. From the Select menu, choose the Check command, or click the Check button on the 
toolbar to select each file's check box.

From the Select menu, choose the Uncheck command, or click the Uncheck button on 
the toolbar to undo all your selections.

4. From the Operations menu, choose the Backup command, or click the Backup button 
on the toolbar.

When only some files are selected, the corresponding disk-drive and directory check boxes 
are dimmed.
See Also
Backing Up all the Files
Setting the Tape Options



Setting the Tape Options

After selecting one or more disk drives, files, or Microsoft Exchange components to back up,
you can use the Backup command on the Operations menu to open the Backup Information
dialog box. The upper section provides information on the tape that you loaded.
To set the tape options
1. In the Operation box, select Append to place the new backup set after the last backup 

set, or select Replace to overwrite all the information on the tape.
2. In the Tape Name box, type a name for the new tape that is fewer than 32 characters 

long.
3. Select the Verify After Backup check box if you want to confirm that the tape was 

backed up accurately .
4. Select the Backup Local Registry check box if you want to add a copy of your Windows 

NT Registry files to the backup set. This option is available only if the drive containing 
the Registry is selected.

5. Select the Restrict Access To Owner Or Administrator check box to secure the tape by 
limiting access to it.

6. Select the Hardware Compression check box if you want to have the tape drive 
compress the data onto the tape media.
Keep in mind, however, that moving tapes between different brands of tape drives can 
cause problems if one brand supports compression and the other does not. Depending 
on the tape drive, the program can display messages such as “Tape Drive Error 
Detected,” Tape Drive Not Responding,” or “Bad Tape.” To erase a tape that is causing 
one of the problems, start NTBackup from the command prompt with the /nopoll 
switch. However, be careful not to use Backup with the /nopoll switch to perform 
anything other than erasing the tape.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Setting the Backup Set Options
Setting the Log Options
Backing Up Individual Files
Backing Up all the Files



Setting the Backup Set Options

The second section of the Backup Information dialog box shows how many backup sets 
have been selected. Each set is a collection of related files on one drive or a Microsoft 
Exchange component that is backed up during a single backup operation. If you select 
more than one disk drive or a combination of drives and Microsoft Exchange components, 
Backup provides a scroll bar for moving between backup sets so you can enter separate 
descriptions (up to 32 characters) and select different backup types for each set.
To set the backup set options
1. In the Backup Set Information box, type a description for the backup set.
2. In the Backup Type box, select the type of backup operation you want.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Setting the Tape Options
Setting the Log Options
Backup Operation Types



Setting the Log Options

In the final section of the Backup Information dialog box, you can choose whether to create 
a log that contains a summary of major operations or full details of all operations. 
To set the log options
1. Select the logging option that you want to use, or select Don't Log.
2. In the Log File box, type the name of the text file to use for logging completed tape 

operations, or use the Browse button at the end of the Log File box to help you locate 
the correct filename for the log.

3. Choose the OK button to display the Backup Status dialog box and start the backup 
process.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Logging Options
Setting the Tape Options
Setting the Backup Set Options
Checking the Backup Status



Checking the Backup Status

The Backup Status dialog box contains an active status area; the names of the drive, 
directory, and file(s) that are being backed up, or the names of the Microsoft Exchange 
components being backed up; and a Summary section showing a log of major operations, 
including whether or not the operation completed successfully. You can also choose to stop 
the backup operation. If a large backup operation reaches the end of a tape before 
finishing, the Insert New Tape dialog box appears and prompts you to insert a new tape. A 
collection of related tapes containing several backup sets is called a family set.
To display the Backup Status dialog box and start or stop backing up
1. In the Backup Information dialog box, choose the OK button.

The Backup Status dialog box appears, and the backup operation begins.
2. Choose the Abort button if you need to stop a backup job before it is completed. When 

the Backup Abort message appears, choose the Yes button. 
A message asks whether to continue or stop now and whether to show it as a 
corrupted file.

See Also
Opening the Tapes Window



Using Batch Files For Backups

You can create a command-line batch file to back up one or more drives or Microsoft 
Exchange Server components on a regular basis. The parameters included in this batch 
command give you most of the same functionality that is provided in the graphical user 
interface. When backing up drives, you can back up only directories, not individual files, 
and you cannot use wildcard characters.
Syntax:
ntbackup operation path [/a][/v][/r][/d "text"][/b][/hc:{on | off}] [/t {option}]
[/l "filename"][/e][/tape:{n}]
Parameters:
operation

Specifies the operation, backup.
path

If you are backing up a drive, specifies one or more paths of the directories to be 
backed up.
If you are backing up Microsoft Exchange components, specifies the component and 
the server using the following format:

{DS server IS server}
server is the name of the server you are backing up preceded by two backslashes 
(for example, \\berkeley). DS indicates that you are backing up the directory, and IS 
indicates that you are backing up the information store.

/a
Causes backup sets to be added after the last backup set on the tape. When /a is not 
specified, the program reuses the tape and replaces previous data. When more than 
one drive is specified but /a is not, the program overwrites the contents of the tape 
with the information from the first drive selected and then appends the backup sets for
the remaining drives.

/v
Verifies the operation.

/r
Restricts access.

/d "text" 
Specifies a description of the backup contents.

/b
Specifies that the local registry be backed up.

/hc:on or /hc:off
Specifies that hardware compression is on or off.

/t {option}



Specifies the backup type. Option can be one of the following:
Normal    All selected files or Microsoft Exchange components are backed up and 
marked as such on the disk.
Copy    All selected files or Microsoft Exchange components are backed up, but they 
are not marked as such on the disk. 
Incremental    Among the selected files or Microsoft Exchange components, only 
those that have been modified are backed up and marked as such on the disk.
Differential    The selected files or Microsoft Exchange components that have been 
modified are backed up, but they are not marked as such on the disk.
Daily    Among the selected files, only those that have been modified that same day 
are backed up, but they are not marked as such on the disk. (This can be useful if you 
want to take work home and need a quick way to select the files that you worked on 
that day.) This option is not available when backing up Microsoft Exchange 
components.

/l "filename" 
Specifies the filename for the backup log. 

/e 
Specifies that the backup log include exceptions only.

/tape:{n}
Specifies the tape drive to which the files should be backed up. N is a number from 0 
to 9 that corresponds to the tape drive number listed in the registry.

See Also
Backup Information Types
Logging Options
Backing Up all the Files



Overview of Backing Up Microsoft Exchange Components

You can use Backup to make backup copies of the Microsoft Exchange server directory and 
the information store. You use the Backup program to connect to a Microsoft Exchange 
server, then back up from or restore to any servers in the organization that share network 
connectivity. During backup, users can continue to access the server being backed up as 
they normally would. However, when restoring information, Microsoft Exchange services 
are brought down, and users cannot access the servers being restored. When backing up 
and restoring Microsoft Exchange components, keep in mind the following points.

The computer that you are logged onto must share network connectivity with all 
servers you are attempting to back up or restore remotely.

When performing a backup, the Windows NT account with which you are logged on 
must be a member of the Backup Operators group on the computer you are running the 
Backup application from as well as all computers you are backing up.

When performing a restore, the Windows NT account with which you are logged on 
must be a member of the Administrators group on the computer you are running the Backup
application from as well as all computers to which you are restoring information.

When performing a backup, you must back up a server's private and public 
information stores as a single entity. However, when restoring, you have the option of 
restoring the private and public information stores separately.

Backup attempts to back up all selected components on all selected servers. If any 
conditions exist that prevent the backup of a selected component from occurring, you will be
prompted with a message, and then the backup will continue for the rest of the components.
Look in the Application event log for more details on the problem.
See Also
Connecting to a Microsoft Exchange Server
Opening the Microsoft Exchange Organization Window
Selecting the Servers to Back Up
Selecting the Microsoft Exchange Components to Back Up
Microsoft Exchange Backup Strategies



Connecting to a Microsoft Exchange Server

If the computer on which you are running Backup is not a Microsoft Exchange server, you 
need to connect to a Microsoft Exchange server before you can back up Microsoft Exchange
components. Once you do, you can back up components on any or all of the servers in your
organization.
Note You can remotely back up only servers that share network connectivity.
To connect to a Microsoft Exchange server
1. From the Operations menu, choose Microsoft Exchange.

The Microsoft Exchange dialog box appears.
2. Type the name of any Microsoft Exchange server in the organization.

If you do not know the exact name of a Microsoft Exchange server, choose the button 
to the right of the text entry box, and select the server you want from the list.

3. Choose the OK button. 
A Microsoft Exchange Organization icon is added to the main Backup window.

See Also
Opening the Microsoft Exchange Organization Window



Select Computer

Choose any Microsoft Exchange Server computer in your organization. The Backup program
reads in the organization hierarchy from the Microsoft Exchange Server computer you 
specify.
Computer
Type the name of a Microsoft Exchange Server computer. If you selected Start Service in 
the Microsoft Exchange dialog box, be sure to type the name of the specific computer on 
which you want to start the service. 
Select Computer
Displays all computers on your network. Select a Microsoft Exchange Server computer from
the list.



Microsoft Exchange

Type the name of the Microsoft Exchange server to which you want to connect. (This can be
the name of any server in the organization.) If you do not know the exact name of the 
Microsoft Exchange server, choose the button to the right of the text entry box, and select 
the server you want from the list. Once you connect to a server, you can back up Microsoft 
Exchange components throughout your organization, or you can start services on the 
server. 
Choose one of the following buttons for information about the dialog box: 
 Connect to Organization
 Start Service



Connect to Organization
Select this option to connect to the server you specified for the purpose of backing up 
Microsoft Exchange components. 



Start Service
Select this option and choose either Directory or Information Store to start the 
corresponding service on the server you specified in the Server box. Use this option if you 
restored Microsoft Exchange components from tape and did not check Start Service After 
Restore in the Restore Information dialog box.



Opening the Microsoft Exchange Organization Window
When you connect to a Microsoft Exchange server, a Microsoft Exchange Organization icon 
appears in the main Backup window. You can open the Microsoft Exchange Organization 
window, which lists all sites in your organization and all servers contained within those 
sites. You can then back up components on any or all of the displayed servers.
Note You can remotely back up only servers that share network connectivity.
To open the Microsoft Exchange Organization window

Double-click the Microsoft Exchange Organization icon in the main Backup window.
See Also
Connecting to a Microsoft Exchange Server
Selecting the Servers to Back Up
Selecting the Microsoft Exchange Components to Back Up
Microsoft Exchange Backup Strategies



Selecting the Servers to Back Up

You can back up all servers in your organization, all servers in one or more sites, or 
individual servers only. You can remotely back up only servers that share network 
connectivity. You can use any of the following methods to select one or more servers.
To select the servers you want to back up

To back up all servers in the organization, select the organization check box.
To back up all servers in a particular site, expand the tree until you see the site you 

want to back up, and select the site check box.
To back up a specific server, expand the tree until you see the server you want to 

back up, and select the server check box.
Note You can back up a Microsoft Exchange server only if your account is a member of 

the Backup Operators group on that server. You can use Windows NT User 
Manager to add an account to the Backup Operators group on a particular server.

See Also
Selecting the Microsoft Exchange Components to Back Up
Microsoft Exchange Backup Strategies
Connecting to a Microsoft Exchange Server
Opening the Microsoft Exchange Organization Window



Selecting the Microsoft Exchange Components to Back Up

Microsoft Exchange components include the directory and the information store. You can 
back up one or both of these components on each of the Microsoft Exchange servers in 
your organization. 
To select the Microsoft Exchange components to back up
1. In the Organization window, select the server that you want to back up.

The Directory and Information Store check boxes appear on the right side of the 
window.

2. Select one or both of the components you want to back up.
Note You can select individual components only for a specific server. If you select a site 

on the left side of the window (to back up all servers in the site) or the 
organization object (to back up all servers in the organization), both the directory 
and the information store are backed up for each server by default.

See Also
Microsoft Exchange Backup Strategies
Connecting to a Microsoft Exchange Server
Opening the Microsoft Exchange Organization Window
Selecting the Servers to Back Up



Microsoft Exchange Backup and Restore Strategies

Backing Up the Directory
It is essential that you maintain a backup copy of the directory on every server since there 
is server-specific information in the directory on each server. If a situation arises where you 
need to restore the directory on a server, simply restore the backed up directory to that 
server. Any changes to the directory that occurred since the last backup will be made 
automatically during replication.
How often you back up the directory on each server depends on how often changes are 
made to the directory in a site. If numerous changes are made (new servers are added, 
new mailboxes are created, and so on), backups should be performed fairly frequently 
(weekly, for example). If fewer changes are made to the directory, backups can be made 
less frequently (monthly, for example). 
A good strategy would be to perform one incremental or differential directory backup per 
site each week, rotating the directory that is backed up. For example, in a site with three 
servers, you would back up server 1 in week 1, server 2 in week 2, and server 3 in week 3. 
This system ensures that each directory backup is reasonably up-to-date.
Note It is important that the directory backup on at least one server per site is kept 

reasonably up to date to protect against data loss if all servers in a site fail.

Backing Up the Information Store
Although you can restore the public information store and the private information store 
individually, you can back them up only as one object. A good strategy is to back up the 
information store incrementally or differentially at least once each day and then perform a 
normal backup weekly.
To do a catastrophic restore
Follow these steps if a server must be replaced by a new computer or the hard drive must 
be reformatted.
1. Install Windows NT on the new computer and be sure to give it the same computer 

name as the old computer.    You may have to remove the old computer account from 
the domain before establishing an account for the new computer.

2. Install Microsoft Exchange Server on the new computer using setup /r when installing. 
In Setup, if you choose to create a new site be sure to specify the same organization 
and site names as the old computer.    It is better to choose to join an existing site if 
there is another online server in your site that you can specify.

Note: You must use the /r switch when running Setup.    In this mode, Setup will not 
start the Microsoft Exchange services or initiate replication, and these operations 
must not be done so that you can restore.

3. Restore the Microsoft Exchange directory service (DS) from the last backup of the old 
server.

4. Restore the private and public information stores from the last backup of the old 
server.

5. Run the DS/IS consistency adjustment.

Restoring the Information Store to an Alternate Server



If you need to restore specific items from a particular mailbox or public folder and you do 
not want to restore over the existing information store, you can restore the information 
store to an alternate server. This alternate server cannot be replicating its directory with 
the existing organization.
To recover specific user mailbox data
1. Find an alternate server that is not replicating with the existing organization.
2. Install Microsoft Exchange Server on the alternate server and create an organization 

and site with the same names as those of the backed up server.
3. Run Backup and restore the information store. In the Restore Information dialog box, 

specify the alternate server name for the Destination Server and check Erase All 
Existing Data.

4. In Microsoft Exchange Administrator, select the server and open its property pages. 
5. Choose the Advanced property page. Under the DS/IS consistency adjustment, select 

All Inconsistencies, and press Adjust.
This runs the DS/IS consistency adjustment to synchronize the directory and 
information store.

6. Give yourself permissions on the mailbox from which you want to restore data. If 
restoring data from a public folder, choose any mailbox.

7. With the User Profile Editor, create a user profile.
8. Log on to the client and move the data to a PST. This PST can then be given to the 

user.



Opening the Tapes Window

The Tapes window is not normally open when you start the Backup program. After opening 
it, you can choose to restore either the current tape, one or more backup sets, or individual 
files. All catalog information is maintained on the corresponding tape for that backup set. 
Family sets have the information on the last tape.
To open the Tapes window

In the main Backup window, double-click the Tapes icon. Or, from the Window menu, 
choose the Tapes window.
The tape name appears in the left panel of the Tapes window to the right of each tape icon. 
The following information is shown in the right panel of the Tapes window:

Drive backed up
Backup set number
Tape number and what number it is in a set of tapes
Backup type
Date and time of backup
Backup description

See Also
Opening and Updating the Drives Window
Backup Operation Types



Loading Catalogs

When you insert a tape to be restored, only information on the first backup set appears in 
the right panel. If you want to restore the entire tape, you need to load the tape's catalog 
to display a list of any other backup sets. If you want to know what files are in each backup 
set, you need to load the individual catalogs for each backup set.
To load catalogs for tapes and backup sets
1. In the Tapes window, select the tape or backup set for which you want a catalog 

loaded.
2. To load a tape's catalog of backup sets, double-click that tape's icon, or choose Catalog

from the Operations Menu or the Catalog button on the toolbar.
The Catalog Status dialog box appears and provides the option of stopping the 
cataloging process.
After searching the tape, a complete list of backup sets appears in the Tapes window, 
with question marks displayed in each of the icons to show that their individual 
catalogs have not been loaded.

3. To load a backup set's catalog of directories and files, double-click that backup set's 
icon. 
The Catalog Status dialog box appears and provides the option of stopping the 
cataloging process.
After searching the tape, a complete list of the directories and files in the backup set 
appears in a Tape File Selection window. The list in the Tapes window now appears with
a plus sign in the backup set's icon to show that it has been cataloged. Corrupt files 
(that is, files that contain errors) and their corresponding directories are marked by a 
symbol with a red X.

See Also
Checking the Backup Status
Restoring Tapes or Backup Sets
Building Partial Tape and Backup Set Catalogs



Restoring Tapes or Backup Sets

The procedures for selecting files to restore are similar to those for selecting files to back 
up. Notice, however, that when you load a tape, only the first backup set on the tape is 
displayed until you load the tape's catalog. Therefore, when you select an entire tape, you 
are really only selecting those sets that are already displayed. Therefore, you must load the
tape's catalog first to get the complete list of backup sets.
To restore a tape or individual backup sets
1. Load the tape's catalog of backup sets.
2. To restore all the files on a tape, in the Tapes window, select the check box for the 

appropriate tape, or select the tape and choose the Check button on the toolbar.
3. To restore a few backup sets, in the right panel of the Tapes window, select the check 

box for each backup set. 
To restore several backup sets, select the first backup set and then do one of the 
following:

Press and hold down the SHIFT key and then select the last contiguous backup set. 
Drag the mouse to the last contiguous backup set.
Press and hold down the CTRL key and then select each non-contiguous backup set.

4. To select each backup set's check box, choose Check from the Select menu, or click 
the Check button on the toolbar.

To undo all your selections, choose Uncheck from the Select menu, or click the 
Uncheck button on the toolbar.
5. From the Operations menu, choose the Restore command, or click the Restore button 

on the toolbar.

Notice that when only some backup sets are selected, the corresponding tape check box is 
dimmed.
See Also
Restoring Individual Files
Setting the Restore Options
Setting the Microsoft Exchange Restore Options
Loading Catalogs



Restoring Individual Files

The procedures for selecting files to restore are similar to those for selecting files to back 
up. Notice, however, that when you load a tape, only the first backup set on the tape is 
displayed until you load the tape's catalog. Therefore, when you select an entire tape, you 
are really selecting only those sets that are already displayed. Therefore, you must load the
tape's catalog first to get the complete list of backup sets. If you want to know what files 
are in each backup set, you need to load the individual catalogs for each backup set.
To restore individual files in a backup set on a tape
1. In the Tapes window, load the catalog of the backup set from which you want to restore

certain files.
The results appear in a Tape File Selection window.

2. To restore a few files, select the check box for each filename.
To restore several files, select the first filename and then do one of the following:

Press and hold down the SHIFT key and then select the last contiguous filename. 
Drag the mouse to the last contiguous filename.
Press and hold down the CTRL key and then select each non-contiguous filename.

3. To select each file's check box, choose Check from the Select menu, or click the 
Check button on the toolbar.

To undo all your selections, choose Uncheck from the Select menu, or click the 
Uncheck button on the toolbar.
4. From the Operations menu, choose the Restore command, or click the Restore button 

on the toolbar.

Notice that when only some files are selected, the corresponding disk-drive and directory 
check boxes are dimmed.
See Also
Restoring Tapes or Backup Sets
Setting the Restore Options
Loading Catalogs



Building Partial Tape and Backup Set Catalogs

If a backup operation spans several tapes and you choose to restore a single backup set, 
you are prompted to insert the last tape to load the tape catalog information and get a 
complete list of all the backup sets and their locations. However, if the last tape in such a 
family set is missing or damaged, you can force Backup to deal with the data on each 
remaining tape as if it were a single unit rather than a member of a family set. This can be 
done by starting Backup from the command prompt with the /missingtape switch. 
However, this process takes additional time.
Sometimes, you will want to restore files that were not backed up with the Windows NT 
Backup program. If the tape has the Microsoft tape format (MTF), Windows NT Backup can 
read it. However, the tape may or may not have the full on-tape catalog (OTC) information 
that Windows NT Backup produces. Also, some older tape backup devices may not support 
creating full on-tape catalogs with the Windows NT Backup program.
To build a catalog from a tape without a full on-tape catalog
1. Insert the MTF-compatible tape in the tape backup device.
2. Load whatever on-tape catalog information is available.

The Catalog Status dialog box appears and provides the option of stopping the 
cataloging process.

If there is no catalog information, the entire tape is scanned to determine all the backup 
sets, and then you must double-click each backup set’s icon to determine its contents.
If there is partial information on the backup sets, that information is accessed quickly, and 
then you must double-click each backup set’s icon to determine its contents.
See Also
Loading Catalogs



Setting the Restore Options

After selecting one or more tapes, backup sets, or files to restore, choose the Restore 
command on the Operations menu to open the Restore Information dialog box. The first 
section provides information about the backup sets on the loaded tape and tells you how 
many other tapes are in that family set. 
To set the restore options
1. In the Restore Information dialog box, specify the drive to which you want each backup

set's information restored.
2. If you want to place a backup set's files into a different directory instead of into the 

original one on the default drive, you can specify an alternate directory path or use the
Browse button at the end of the Alternate Path box to help you find the correct path.

3. Select the Verify After Restore check box if you want to verify the contents of the files 
restored to disk against the files on tape and log any exceptions.

4. Select the Restore Local Registry check box if you want to restore the Registry files.
5. Select the Restore File Permissions check box if you want to restore the permissions 

information along with the file. 
Otherwise, the files inherit the permissions information of the directory to which they 
are restored.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Setting the Log Options
Restoring Tapes or Backup Sets
Restoring Individual Files



Setting the Microsoft Exchange Restore Options

After selecting one or more tapes, backup sets, or Microsoft Exchange components to 
restore, choose the Restore command on the Operations menu to open the Restore 
Information dialog box. The first section provides information about the backup set(s) on 
the loaded tape and tells you how many other tapes are in that family set. 
Note You must have Administrator rights on every server to which you are attempting to

restore Microsoft Exchange components.
To set the restore options for each backup set
1. If you want Backup to attempt to restore any data that was created or changed since 

the last backup was made, do not select Erase All Existing Data.
2. If you want to erase data in the target directories and restore only the data that was 

backed up to tape, select Erase All Existing Data.
3. If restoring an information store, in the Destination Server box, type the name of the 

server where you want to restore the information store from the tape. Select the 
Private check box to restore the private information store to the specified server. 
Select the Public check box to restore the public information store on the specified 
server.

4. Select the Verify After Restore check box to verify the contents of the files restored 
onto disk against the files on tape and log any exceptions.

5. Select the Start Service After Restore check box to restart the Directory and/or 
Information Store service once the restore is complete.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Setting the Log Options
Restoring Tapes or Backup Sets



Setting the Log Options

In the bottom section of the Restore Information dialog box, you can choose whether or not 
to create a log that contains a summary of major operations or full details of all operations. 
To set the log options
1. Select the logging option that you want to use or select Don't Log.
2. In the Log File box, type the name of the text file to use for logging completed tape 

operations, or use the Browse button at the end of the Log File box to help you locate 
the correct filename for the log.

3. Choose the OK button to display the Restore Status dialog box and start the restore 
process.

For more information on the various options, choose the Help button or press F1 while 
using the dialog box. 
See Also
Setting the Restore Options
Checking the Restore Status
Logging Options



Transaction Log Files and Circular Logging

The Microsoft Exchange database is transaction-based, and NT Backup uses this feature to 
provide an unobtrusive backup while users are active on the server. 
Transaction Log Files
Microsoft Exchange Server uses a write-ahead transaction log file for both the information 
store and the directory databases. Modifications to the database can be synchronously 
secured to a sequentially accessed transaction log file on the disk at the same time they 
are written to the in-memory database cache. Transaction log file names have the form 
EDBXXXXX.LOG, where X is the hexadecimal number from 0 to F, and are stored in the 
MDBDATA and DSADATA subdirectories by default.
The size of each log file is 5 MB. All write transactions that are performed on the Microsoft 
Exchange database are stored in the in the transaction log files.
Data in the in-memory cache is then later asynchronously written to the database file as 
necessary. When the log file reaches its 5-MB limit, a new logging file is generated and the 
log number of the current logging file is incremented in hexadecimal.
Circular Logging
Depending on the amount of data that is logged to the databases, the number of log files 
can grow quickly. If you don’t plan to do incremental or differential backups, you can use 
the circular logging feature, which prevents the continuous build up of transaction log files. 
Circular logging overwrites the oldest transaction log files after the information it contains 
has been committed to the database. 
Circular logging is turned on in the Advanced property page for the Server object in 
Microsoft Exchange Administrator. This feature is turned off by default.
Circular logging reduces disk storage space requirements; the log files will typically be less 
than 100 MB. However, keep in mind that if circular logging is enabled, you cannot perform 
differential or incremental backups. During full backup, the Backup program backs up all 
Microsoft Exchange Server components and all log files with data that has not yet been 
committed to the database.
Note    You should either be doing regular backups, or have circular logging turned on, so 
that transaction log files do not continue to accumulate. Do not manually delete log files.

Backup Type Transaction & Circular Logging
Normal All transaction log files with data that 

has already been committed to the 
database are deleted.

Copy No transaction log files are deleted.
Incremental The transaction logs generated since 

the last backup, including those 
containing data not yet committed to 
the database, are backed up. All log 
files with data that has already been 
committed to the database are 
deleted. Enabling circular logging 
disables incremental backup.



Differential The transaction logs generated since 
the last backup, including those 
containing data not yet committed to 
the database, are backed up. No 
transaction log files are deleted. 
Enabling circular logging disables 
differential backup.

See Also
Backup Operation Types



Checking the Restore Status

The Restore Status dialog box contains an active status area; the names of the drive, 
directory, and files that are being restored, or the names of the Microsoft Exchange 
components being restored; and a Summary section showing a log of major operations, 
including whether or not the operation completed successfully. You can also choose to stop 
the restore operation. If the restore operation reaches the end of a tape before finishing, 
the Insert New Tape dialog box prompts you to insert a new tape. 
To display the Restore Status dialog box and start or stop restoring
1. In the Restore Information dialog box, choose the OK button.

The Restore Status dialog box appears, and the restore operation begins.
2. Choose the Abort button if you need to stop a restore job before it is completed. When 

the Restore Abort message appears, choose the Yes button. 
A message asks whether to continue or stop now.



Erasing Tapes

The Erase Tape command causes the whole tape to be erased. You can do either a Quick 
Erase, during which the tape header is rewritten, or a Secure Erase, during which the entire
tape is overwritten. The secure-erase method can take several hours to complete, 
depending on the drive technology and tape length. You should categorize the information 
on the backup tapes by which method of erasing to use and then create and maintain a list 
for easy reference.
To erase a tape
1. From the Operations menu, choose Erase Tape, or click the Erase Tape button on the 

toolbar.
2. In the Erase Tape dialog box, choose either Quick Erase or Secure Erase.

A warning message advises you that all the information on the tape will be destroyed. 
It also gives you the name of the tape and when it was created.

3. Choose the Continue button.



Retensioning Tapes

The Retension Tape command removes loose spots on the tape by fast forwarding to the 
end of the tape and then rewinding. This procedure winds the tape evenly so it will run 
more smoothly past the tape drive heads.
To retension a tape

From the Operations menu, choose Retension Tape, or click the Retension Tape button
on the toolbar.
To reduce tape slippage, manufacturers of tape backup drives recommend that you 
retension .25-inch tape once every 20 uses. The Retension Tape command is not available 
for 4 mm and 8 mm tapes because they do not require retensioning. How much time is 
spent forwarding and rewinding the media depends on the device technology. For specific 
retensioning requirements see the manufacturer's documentation.



Formatting Tapes

The Format Tape command formats an unformatted mini-cartridge tape. This type of tape is
treated like a floppy disk and must be formatted before it can be used. If you do not have a 
mini-cartridge drive installed and activated, this command is unavailable.
To format a tape

From the Operations menu, choose Format Tape.



Eject Tape

Rewinds the tape and then ejects the tape from the tape drive. You can eject a tape only 
from a drive that supports electronic tape ejection. If it does not, the tape is rewound in 
preparation for manual ejection.
Notice, however, that clicking the Eject Tape button when using certain tape drives can 
cause the tape not to eject and the program to display “No Tape in the Drive.” If this occurs,
eject the tape manually from the drive.



Exit

Quits Backup.



Catalog

Adds a tape’s catalog information to the disk.
See Also
Loading Catalogs
Building Partial Tape and Backup Set Catalogs



Expand One Level

Expands one level of a collapsed directory in the directory tree and displays the directory 
one level below the currently selected directory.



Expand Branch

Expands a collapsed directory, including all of its subdirectories, in the directory tree and 
displays the entire directory tree below the currently selected directory.



Expand All

Expands all the branches in the directory tree and displays the entire directory tree of the 
drive displayed in the active window.



Collapse Branch

Collapses directory levels below a selected directory in the directory tree and removes the 
directory tree of the currently selected directory from the File Selection window.



Tree and Directory

Changes the File Selection window to display the directory tree in the left panel and the file 
list in the right panel.



Tree Only

Displays only the directory tree in the File Selection window.



Directory Only

Displays only the contents of the current directory in the File Selection window.



All File Details

Displays all available information about files and directories in the File Selection window. 
This information includes the filename, size, last modification date and time, and file 
attributes for each file. This command does not affect the directory tree.



Status Bar

Displays or hides the status bar at the bottom of the Backup window. The status bar shows 
the status of current program activity and also provides basic information on each selected 
command. A check mark next to the Status Bar command means that it is in effect.
See Also
Showing or Hiding the Status Bar and Toolbar



Toolbar

Displays or hides the toolbar in the Backup window. A check mark next to the Toolbar 
command means that it is in effect.
See Also
Showing or Hiding the Status Bar and Toolbar



Check

Places a check mark in the check box of highlighted selections.
See Also
Backing Up all the Files
Backing Up Individual Files
Restoring Tapes or Backup Sets
Restoring Individual Files



Uncheck

Removes a check mark from the check box of highlighted selections.



Cascade

Arranges windows so that they overlap. The title bar of each window remains visible, 
making it easy for you to select any window.



Tile

Arranges the windows side by side, so that each window is visible and none overlap.



Arrange Icons

Arranges all of the minimized windows into rows at the bottom of the display.



Refresh

Updates the contents of the active window.



Close All

Closes all but the application window. The Drives and Tapes windows will be minimized.



Names of Open Windows

To make an open window active, choose its name from this list. All open windows are listed,
including those that have been reduced to icons.
See Also
Opening and Updating the Drives Window
Opening the Tapes Window



Control Menu

The Control menu contains the following commands:
Restore
Restores the window to its former size after it has been maximized or minimized.
Move
Enables you to use the keyboard to move the window to another position.
Size
Enables you to use the keyboard to change the size of the window.
Minimize
Reduces the window to an icon.
Maximize
Enlarges the window to its maximum size.
Close
Quits an application, or closes a window or dialog box.
Switch To
Starts Task List, which you can use to switch between running applications and to rearrange
their windows and icons.



Contents

Starts Help and displays the topics in Backup Help.



Search for Help on

Opens the Search dialog box for Help. You can look up Help information by using keywords 
in the dialog box.



How to Use Help

Describes how to use Help.



About Backup

Displays version and copyright information about Backup.



Backup Information

After selecting one or more disk drives, files, or Microsoft Exchange components to back up,
you can use the Backup command to back up your information to tape. The upper section 
of the Backup Information dialog box provides information on the tape that you loaded. The
second section shows how many backup sets have been selected, each set being a 
collection of related files on one drive, or a Microsoft Exchange component. In the final 
section, you can choose whether to create a log that contains a summary of major 
operations or full details of all operations.
Choose one of the following buttons for information about the dialog box: 
 Current Tape
 Creation Date
 Owner
 Tape Name
 Verify After Backup
 Backup Local Registry
 Restrict Access to Owner or Administrator
 Hardware Compression
 Operation
 Backup Set Information
 Log Information

See Also
Overview of Backing Up Microsoft Exchange Components
Backup Operation Types
Logging Options
Setting the Tape Options
Setting the Backup Set Options
Setting the Log Options



Restore Information

Windows NT provides a Restore command to give access to tapes, backup sets, or files for 
restoring as they are needed. The first section in the Restore Information dialog box 
provides information about the backup sets on the loaded tape and tells you how many 
other tapes are in that family set. In the bottom section, you can choose whether or not to 
create a log that contains a summary of major operations or full details of all operations. 
Choose one of the following buttons for information about the dialog box: 
 Backup Set Information
 Log Information

See Also
Logging Options
Setting the Restore Options
Setting the Log Options



Microsoft Exchange Restore Information

Windows NT provides a Restore command to give access to tapes, backup sets, or Microsoft
Exchange components for restoring as they are needed. The first section in the Restore 
Information dialog box provides information about the backup sets on the loaded tape and 
tells you how many other tapes are in that family set. In the bottom section, you can 
choose whether or not to create a log that contains a summary of major operations or full 
details of all operations. 
Note When restoring Microsoft Exchange components, you must have Administrator 

rights on every server to which you are attempting to restore components.
Choose one of the following buttons for information about the dialog box: 
 Backup Set Information
 Log Information

See Also
Logging Options
Setting the Microsoft Exchange Restore Options
Setting the Log Options



Microsoft Exchange

The Microsoft Exchange command lets you connect to a Microsoft Exchange server for the 
purpose of backing up Microsoft Exchange components, or starting services on the server. 
Once you connect to a Microsoft Exchange server, a Microsoft Exchange Organization icon 
is added to the main Backup window.
See Also
Connecting to a Microsoft Exchange Server
Opening the Microsoft Exchange Organization Window



Erase Tape

Removes data and sensitive information from a tape. You can do either a Quick Erase, 
during which the tape header is simply rewritten, or a Secure Erase, during which the entire
tape is overwritten. The Erase Tape dialog box also shows the name of the tape and when 
the tape was created. 
Choose one of the following buttons for information about the dialog box: 
 Quick Erase
 Secure Erase

See Also
Erasing Tapes



Retension Tape

This dialog box enables you to run the tape its entire length and rewind, at a fast speed, to 
tension the tape evenly. This operation is not necessary on 4 mm and 8 mm tape drives, 
and so the option is unavailable when using them. 
See Also
Retensioning Tapes



Format Tape

The Format Tape command formats an unformatted mini-cartridge tape. This type of tape is
treated like a floppy disk and must be formatted before it can be used. If you do not have a 
mini-cartridge drive installed and activated, this command is unavailable.
See Also
Formatting Tapes



Status

The same dialog box appears for backup, restore, and cataloging operations. All give you 
the option of stopping the current operation.
Additional information provided for the backup and restore operations includes the selected
tape, disk drive, directory path, and filename, or the selected Microsoft Exchange 
components.
The cataloging operation normally has only a Summary section. However, if there is no 
on-tape catalog, a larger box appears with more extensive status information, such as 
that provided for backup and restore.
Choose one of the following buttons for information about the dialog box: 
 Status area
 Summary section

See Also
Checking the Backup Status
Checking the Restore Status
Loading Catalogs
Building Partial Tape and Backup Set Catalogs



Insert New Tape

This dialog box appears when you need to insert a new tape. This can happen when 
individual files or backup sets span two or more tapes.



Abort

If you need to stop a restore or backup job before it is completed, choose the Abort button. 
A message asks whether to continue or stop now.



Hardware Setup

The system automatically checks for the proper hardware when you start Windows NT and 
initializes it each time you start backup. However, if you have more than one tape backup 
device, you can use this dialog box to select a different device.

Open the Tape Drive box and select the new backup device, or type a device name in 
the box. Then choose OK.

Windows NT currently supports both high-capacity SCSI tape backup devices for 4 
mm DAT, 8 mm, and .25-inch drives, and the less expensive mini-cartridge drives. You can 
have more than one tape drive connected to your system. However, only one tape drive can 
be selected at a time.
Inserting a higher density tape than the tape drive can use can cause the program to 
display “Tape Drive Error Detected” and not allow the tape to be ejected until you close 
Backup. 
Running Backup without a tape in certain tape drives can cause the Application log in Event
Viewer to be updated every 3 to 4 seconds with a “No Tape in Drive” message. This can 
eventually fill up the log and leave no room for other messages until you delete the log.
See Also
Loading a Tape Driver
Changing to a Different Tape Drive



Font

This dialog box lets you change your font selection, the same as you can do in File 
Manager. The Font command affects all directory windows.
Choose one of the following buttons for more information about the dialog box:
 Font
 Font Style
 Size
 Lowercase
 Sample

See Also
Changing the Font Selection



Current Tape

This option shows the current tape's name, which you can modify with the Tape Name 
command, unless there is no tape loaded, it is blank, or it has an unrecognized format.



Creation Date

This option automatically shows the creation date of the original backup set or the date 
when it was last replaced.



Owner

This option automatically shows whoever put the first backup set on the tape.



Tape Name
Type a name for the tape that is up to 32 characters long.



Verify After Backup

This operation performs a verification comparison of the files that are written to tape 
with the files on the disks.

Choose this option to confirm that the tapes were backed up correctly. 



Backup Local Registry
Choose this option to add a copy of your local Windows NT Registry files to the 

backup set. This option is available only if the drive containing the Registry is selected.



Restrict Access to Owner or Administrator

Only the tape owner or a member of the Administrators or Backup Operators group, can 
read, write, or erase the tape using the Windows NT Backup program. To restore it on 
another computer in the same domain, you must be logged on with the same user 
account name for that domain. Members of the Administrators or Backup Operators 
group can read, write, or erase a tape on any computer and in any domain.

Choose this option to secure the tape by limiting access to only the tape owner or a 
member of the Administrators or Backup Operators group. 



Hardware Compression
Select Hardware Compression to request that the tape drive compress the data onto 

the tape media. However, do not select this option if you later want to move this tape to 
another tape drive that does not support hardware compression. 
This option is available only if the tape drive supports selectable hardware compression.



Operation
Select Append to add the backup sets to the end of the last backup set on the active 

tape. Tape Name and Restrict Access to Owner or Administrator are unavailable with this 
operation.

Select Replace to overwrite all the information on the tape. However, if you do not 
confirm the choice, another message gives you the option of appending instead.



Backup Set Information

If you select more than one disk drive or a combination of disk drives and Microsoft 
Exchange components, Backup provides a scroll bar for moving between backup sets so 
you can enter separate descriptions, up to 32 characters, and select different backup 
types for each set selected. If you are backing up drives, the Drive Name box 
automatically shows the name of the drive, if any. If you are backing up Microsoft 
Exchange components, the Microsoft Exchange Component field shows the name of the 
components.

In the Description box, you can type a description for the backup set.
In the Backup Type box, open the list and then select the type you want to use.



Backup Operation Types

Normal (Full) Backup
All the selected files are backed up and marked as such on the disk.
For Microsoft Exchange, all Microsoft Exchange Server components are backed up. All 
transaction log files with data that has already been committed to the database are 
deleted. A normal backup is the same as a full backup. 
Copy
All the selected files are backed up, but they are not marked as such on the disk.
For Microsoft Exchange, all Microsoft Exchange Server components are backed up. No 
transaction log files are deleted. Use this type if you want to copy the database files 
without interrupting a series of differential or incremental backups.
Incremental
Among the selected files, only those that have been modified are backed up and marked as
such on the disk.
For Microsoft Exchange, only those Microsoft Exchange Server components that have been 
modified since the last normal or incremental backup are backed up. The transaction logs 
generated since the last backup, including those containing data not yet committed to the 
database, are backed up. All log files with data that has already been committed to the 
database are deleted. This type is not available if circular logging is enabled. In other 
words, incremental backup backs up the log files from the last backup (full or incremental) 
up to the current log file checkpoint and, if successful, removes the transaction log files 
from disk.
Differential
The selected files that have been modified are backed up, but they are not marked as such 
on the disk.
For Microsoft Exchange, the Microsoft Exchange Server components that have been 
modified since the last normal backup are backed up. The transaction log files generated 
since the last backup, including those containing data not yet committed to the database, 
are backed up. No transaction log files are deleted. This type is not available if circular 
logging is enabled. Differential backup is the same as incremental backup, except that the 
log files are not removed from the disk.
Daily
Among the selected files, only those that have been modified that same day are backed up,
but they are not marked as such on the disk. (This can be useful if you want to take work 
home and need a quick way to select the files that you worked on that day.) 
Note    The daily backup option is not available when backing up Microsoft Exchange 
components.
See Also
Transaction Log Files and Circular Logging



Log Information
In the Log File box, specify a text file for logging completed tape operations or use 

the Browse button to help locate the correct filename for the log.
Choose one of the Logging Options.



Logging Options

To return to the Backup Information dialog box, choose the Back button.

The following are descriptions of the three logging options.

Logging 
option

Description

Full Detail Logs all 
operations 
information 
including the 
names of all the 
files and 
directories that 
are backed up.

Summary 
Only

Logs only the 
major operations
such as loading 
a tape, starting 
the backup, and 
failing to open a 
file.

Don't Log No information is
logged.



Logging Options

To return to the Restore Information dialog box, choose the Back button.

The following are descriptions of the three logging options.

Logging 
option

Description

Full Detail Logs all 
operations 
information 
including the 
names of all the 
files and 
directories that 
are restored.

Summary 
Only

Logs only the 
major operations
such as loading 
a tape, starting 
the restore 
process, and 
failing to create 
a file.

Don't Log No information is
logged.



Microsoft Exchange Backup Set Information

If you are restoring Microsoft Exchange components, the Backup Set Information dialog 
box automatically provides you with information about the current tape's name, the 
name of the backup set, the creation date or the date when the backup set was last 
replaced, and the name of whoever put the first backup set on the tape. The following 
are various options you can choose in the dialog box.

Select Erase All Existing Data to erase data in the target directories and restore only 
the data that was backed up to tape. Do not select this if you want Backup to attempt to 
restore any data that was created or changed since the last backup was made.

In the Destination Server box, type the name of the server where you want to restore 
from the tape. This is available only for the information store.

Select the Private check box to restore the private information store to the specified 
server. 

Select the Public check box to restore the public information store to the specified 
server. 

Select the Verify After Restore check box to verify the contents of the files restored to
disk against the files on tape and then log any exceptions. 

Select the Start Service After Restore check box to restart the Directory or 
Information Store services on the server once the restore is complete. 



Backup Set Information

If you are restoring drives and files, the Backup Set Information dialog box automatically 
provides you with information about the current tape's name, the name of the backup 
set, the creation date or the date when the backup set was last replaced, and the name 
of whoever put the first backup set on the tape. The following are various options you 
can choose in the dialog box.

Open the Restore to Drive list box and choose the drive to which you want the 
information restored. Or type a drive letter in the box.

To specify an alternate directory path, type a path in the Alternate Path box, or use 
the Browse button at the end of the Alternate Path box to help you find the correct path.

Select the Verify After Restore check box to verify the contents of the files restored 
onto disk against the files on tape and then log any exceptions. 

Select the Restore File Permissions check box to restore the permissions information 
along with the file. Otherwise, the files inherit the permissions information of the directory 
into which they are restored.

Select the Restore Local Registry check box to restore the Registry files. You will need
to restart the computer for the restored information to take effect.



Quick Erase
Choose this option to rewrite the tape header.



Secure Erase
Choose this option to overwrite the entire tape.
This method can take several hours to complete, depending on the drive technology 

and tape length. 



Status area

The status area at the top of the box shows the following information:
Directories, files, and bytes processed.
Elapsed time in hours, minutes, and seconds.
Number of corrupt or skipped files (that is, files that are unable to be copied because 

of both read errors and open/locked files).



Summary section

The summary section shows the tape label and an event log of major operations.



Font
Select a font from the list.
The Sample box displays the font. You can also use the dialog box to change the size 

and style of the font.



Font Style
Select a style for the font.
The Sample box displays the font style. You can also use this dialog box to change 

the type of font and its size.



Size
Select a point size from the list; the larger the point size, the larger the character 

displayed on your screen.
The Sample box displays the font size. You can also use this dialog box to change the 

font and the font style.



Lowercase
Select this option to display all filenames in lowercase characters.



Sample

This box shows what the currently selected font, style, and size would look like in your 
directory windows.



Split

Splits a directory window. If the window is already split, this command moves the split bar 
to the left or right. 

Choose this command and a vertical bar appears in the window. Use the mouse or 
the arrow keys to move the bar, and then either click the bar or press ENTER. You can press 
ESC to cancel the command.



Transaction Log File
Files used for backup and recovery that store all write transactions performed on the 
Microsoft Exchange database. Transaction log files are stored in the MDBDATA and DSDATA 
subdirectories, and their names have the form EDBXXXXX.LOG, where X is a hexadecimal 
number from 0 to F. The default size of each complete log file is 5 MB.



Log File Checkpoint
Indicates the earliest point where a database operation is logged (whether committed or 
not), but its corresponding changes on database pages are not flushed to disk yet. Jet will 
replay the log to recreate the unflushed database pages during recovery.



Database Page
The Microsoft Exchange database is a sequence of pages, each of which is a 4K block of 
data.



Circular Logging
Automatically deletes transaction log files after the information they contain has been 
committed to the database, reducing disk storage space requirements. This feature is 
turned off by default when Microsoft Exchange Server is installed.



Backup Read Pointer
A logical pointer into the database file that indicates what part of the database file has 
been processed.




